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ABSTRACT

This project will be used in order to produce an overall design for Home Automation System,
providing a low-cost system and wireless system. It addresses the development of an Internet
of Things-based home automation system that allows any person to control all the various
components using the internet or automatically program it to work according to ambient
conditions. In this project, we design the development of firmware for smart control that could
eventually become automated successfully and minimizes human interaction in preserving the
integrity within whole electrical devices in the home. In this project, we have used Node MCU,
which is one of the most popular and open-source IoT platforms for its execution process. The
different parts of the system are going to use the different modes of transmission to transfer the
command from the user in Node MCU to the real appliance. Main control system employs
wireless technology by providing access at a remote location with the smartphone. We will use
a cloud server-based communication that would enhance the practicality of the project by
allowing unfettered access to the appliances by the user regardless of the distance factor. We
gave a data transmission network that created a stronger automation. The system is meant for
electrical appliances and devices in the house with a relatively low-cost design, an intuitive
interface and ease of installation. It would display the appliance status along with the control
on an Android platform. It is a system to be supporting and assisting others in the goal of
gratifying the needs of the elderly and the disabled in their homes. In addition, about the system
with the smart home concept integrated into it, it gives improved living standards within the

confines of the house.
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CHAPTER 1: INTRODUCTION

Internet of Things (I0T) 1s a concept where cach device is assigned to an IP address. And
through that IP address, anyone can make that device identifiable over internet. Unique
identifiers UIDs are assigned to the mechanical and digital machines, so that it could transfer
data over a network without human-to-human or human-to-computer interaction. Basically, it
started as the "Internet of Computers." Research studies have forecast an explosive growth in
the number of "things" or devices that will be connected to the Internet. The resulting network
i1s called the "Internet of Things" (IoT). The recent developments in technology which permit
the use of wireless controlling environments like, Bluetooth and Wi-Fi that have enabled
different devices to have capabilities of connecting with each other. Utilizing a WIFI shield to
serve as a Micro web server for the Arduino which eliminates the need to use wired connections
between the Arduino board and computer which cuts the cost and makes it possible to work as
a standalone device. The Wi-Fi shield requires being connected to the internet, either via a
wireless router or a wireless hotspot and this will serve as the gateway for the Arduino to
communicate with the internet. Keeping this in mind, an internet based home automation
system for remote control and monitoring the status of home appliances is designed. Because
of advancements in wireless technology, several different types of connections are introduced-

such as GSM, WIFI, and BT.

Each of the connections has their own specifications and applications. Among the four popular
wireless connections that often implemented in HAS project, WIFI is being chosen with its
suitable capability. The capabilities of WIFI are more than enough to be implemented in the

design. Also, most of the current laptop/notebook or Smartphone come with built-in WIFI

adapter. It will indirectly reduce the cost of this system.




CHAPTER 2: LITERATURE SURVEY

“Smart Energy Efficient Home Automation System using 10T", by Satyendra K.

Vishwakarma, Prashant Upadhyaya, Babita Kumari, Arun Kumar Mishra.

In this paper, a step-by-step procedure of a smart home automation controller is
presented. This design uses IOT that converts home appliances into smart and intelligent
devices with the help of design control. This energy-efficient system is designed such
that 1t accesses the smart home remotely using IOT connectivity. The proposed system
mainly demands, Node MCU as the microcontroller unit, IFTTT to interpret voice
commands. Adafruit a library that supports MQTT acts as an MQTT broker and
Ardumo IDE to code the microcontroller. This multimodal system utilizes Google
Assistant along with a web-based application for controlling the smart home. The smart
home 1s implemented with a main controller unit that is connected with the 24-hour
available Wi-F1 network. For making surc that the Wi-Fi connection never turns oft, the
main controller is programmed automatically to connect with the available network and

also 1s connected with the auto power backup.

“lIOT Based Smart Security and Home Automation”, by Shardha Somani, Parikshit
Solunke, Shaunak Oke, Parth Medhi, Prof. P. P. Laturkar.

This paper focuses on a system which provides features of Home Automation relying
on IOT to work easily, besides having a camera module and providing home security.
The android application basically converts Smartphone into a remote for all home
appliances. This can be achieved by using motion sensors and installing at the house
entrance. The motion sensor can sense if movement is sensed then it can send a message
to the owner of the house carrying a real time photo of the house entrance such that an
application can trigger a notification. Thus, an owner can raise alarm in case of any
intrusion or he /she can toggle the appliances like opening the door in case the person
1s a guest. The system is utilising Raspberry Pi, a small sized computer which acts as a

server for the system. The smart home consist two modules. Home automation that




includes: fan light and door controller, and security module that includes: smoke sensor

motion sensor and camera module.

“4 Dynamic Distributed Energy Management Algorithm of Home Sensor Network

for Home Automation System”, by Tui-Yi Yang, Chu-Sing Yang, Tien-Wen Sung.

This paper considers an optimization of the home power consumption based on PLC
to offer easy access to home energy consumption. In addition, it proposes a renewable
energy gateway for monitoring the energy generation of renewable energies based on
Zigbee and PLC. ACS and DDEM algorithm are proposed for designing an intelligent
power distribution of the power management system to ensure constant ongoing power
supply for home networks. The power supply models for home sensor nctwork fall
classified into groups, namely main supply only, main supply and backup battery,
rechargeable battery power, and non-rechargeable battery power, aiming at efficient
power management with efficient power supply. Devices with unique features are

assigned to these groups, which plan a real time processing scheme to counter variable
sensor network topologies.

“Enhance Smart Home Automation System based on Internet of Things”, by Tushar

Churasia and Prashant Kumar Jain.

This paper proposes a system that develops a model to reduce the computation overhead in
existing smart home solutions that uses various encryption technologies like AES, ECHD,
hybrid, etc. These solutions use intermediate gateway for connecting various sensor devices. It
provides a method for automation along with sensor-based learning. The system uses
temperature sensor for development but other sensors can also be used as per the requirement.
These sensor smart home devices can configure themselves autonomously and can work
automatically without human assistance. This work minimizes encryption decryption and
focuses mainly on authentication and the automation of smart home devices with a learning
mechanism. The system bypasses the local gateway mentioned in the existing system to
provide better security for smart home devices and sensor data and save computation overhead.
The real time broker cloud is directly connected to a smart home and manages all incoming
and outgoing requests between users and devices. The mamn purpose for using real time broker

cloud is to save the time of cryptographic operations.

ﬁ



CHAPTER 3: THEORY

3.1 10T (Internet of Things)

10T refers to an interconnected system of uniquely identifiable entities called 'things' that can

communicate with cach other over the internet without any form of human intervention. It

employs various technologies including machine learning, embedded systems, and sensors,

improving automation and analytics so as to facilitate complete transparency, control, and

performance within different sectors.

3.1.1 Characteristics of loT

Intelligence: Algorithms, software, and hardware collaborate for smart action and
response for the completion of jobs.

Connectivity: Devices are linked together and thus help in achieving collective
intelligence and new possibilities in life.

Dynamic Nature: Tracks changing states of devices (e.g. sleeping, location) and
contexts.

Impressive Scale: Supports billion devices, with appropriate data management.
Sensing: Sensors arc used for data collection for insights into the environment.
Heterogeneity: Provides connectivity between different devices across various

platforms and networks.

Security: Addresses privacy risks, sccuring devices, networks, and data.

3.1.2 Advantages of loT

Communication: Facilitates frictionless interaction of devices to device (M2M).
Automation and Control: Saves human power through central, wireless control.
Information: Provides informed decision through real-time data.

Monitoring: Tracks resources and conditions to improve safety and efticiency.

Time and Money Savings: Increases efficiency and saves on the use of resources and
costs.

Improved Quality of Life: It enhances convenience and better management of daily

activities.



3.1.3 Limits of loT

. Interoperability Problem: There is no common standard for devices.

. Complexity: High risks of system breakdowns.

. Privacy and Sccurity Risk: Theft and cyberattacks.

. Safety Issucs: Errors or hacking can causc massive destructive damage.
. Job Loss: It reduces the necessity of the less skilled workforce.

. Dependence on JoT: Excessive usage may negatively impact life.

3.1.4 Applications of loT

e Wecarables: It comprises a fitness bracclet and smartwatches.

¢ Smart Home: Comfort and automation through technologies.

e Hecalthcare: Predictive wellness solutions and cutting-edge medical devices.

¢ Agriculture: The IoT-based greenhouse to practical farming.

e Industrial Automation: Optimize production, inventory, and logistics.

e Governance and Safety: Enhances police presence, town and city planning, and

economic governance.

3.1.5 IoT Technologies and Protocols

« Bluetooth: A short-range, low-cnergy protocol for wearable devices.

ZigBee: A low-power, secure protocol for industrial ToT.

» Z-Wave: Developed for home automation with simple communication standards.



3.2 NODE MCU

NodeMCU is an open-source 10T platform that arrives low-cost. It was available with in-
built firmware from the earlier days, which runs on the ESP8266 Wi-Fi SoC from Espressit
Svstems. The hardware part utilized the  ESP-12 module.  Later additions  arc support

for ESP32 32-bit MCU..

Figure. Node MCU Development Board.

NodeMCU is an open source firmware for which open source prototyping board designs are
available. The name "NodeMCU" combines "node" and "MCU" (micro-controller unit).

Strictly speaking, the term "NodeMCU" refers to the firmware rather than the associated

development Kkits.
Open-source is also the firmware, as well as the prototyping board designs.

It's built using the Lua scripting language. The firmware is based on the cLua project and the
Espressif Non-OS SDK for ESP8266. A lot of open source projects are used, such as lua-cjson
and SPIFFS. Due to resource constraints, users have to select the modules relevant for a specitic
project and prepare a firmware built for their nceds. Support of the 32-bit ESP32 is also

implemented.

The prototyping hardware commonly used is a circuit board that acts as a dual in-line package
(DIP) which integrates a USB controller with a smaller surface-mounted board containing the
MCU and antenna. The DIP format as chosen for the design makes prototyping on breadboards
relatively easy. The initial design was based on the ESP-12 module of the ESP8266, which 1s

a Wi-F1 SoC integrated with a Tensilica Xtensa L.X106 core, widely used in [OT applications.

R —————— e ——
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3.2.1 Pin Configuration of Node MCU Development Board

This module provides access to the GPIO subsystem. All the access is based on an /0 index
number of Node MCU kits rather than internal GPIO pins. For example, the pin DO on the
development kit is mapped to a GPIO pin 16. Node MCU provides access to GPIO pins and

the following pin mapping table is part of the API documentation.

The ESP8266 Node MCU has total 30 pins which interface it to the outside world. The pins

are classified according to functionality into three categories:

Power pins: There are four power pins viz. one VIN pin & three 3.3V pins. The VIN pin can
be used to power your ESP8266 directly along with other peripherals, if you have a regulated
5V voltage source. The 3.3V pins are the output of an on-board voltage regulator. These pins

can be used to power external components.
GND: Ground pin of ESP8266 Node MCU development board.

12 IC Pins: hook up all sorts of 12C sensors and peripherals to your project. Both 12C Master
and 12C Slave are supported. The 12C interface can be realized programmatically; the
maximum clock frequency is 100 kHz. Keep in mind that the 12C clock frequency must be

higher than the slowest clock frequency of the slave device.

GPIO Pins: ESP8266 Node MCU GPIO has a number of 17 pins that can be programmed for
12C, 12S, UART, PWM, IR Remote Control, LED Light and Button. For each GPIO that is
digitally enabled, it can be configured as an internal pull-up or pull-down or be set to high
impedance. When it is sct up as an input, it may be further set to edge-trigger or level-trigger

for generation of CPU interrupts.

ADC Channel: The Node MCU interfaced with a 10-bit precision SAR ADC. The two
functionalities can be performed through ADC viz. Testing the power supply voltage of
VDD3P3 pin and testing the input voltage of TOUT pin. However, they cannot be done at the

same time.
UART Pins: ESP8266 Node MCU has 2 UART interfaces, i.e. UARTO and UARTI, which
provide asynchronous communication (RS232 and RS485), and can communicate at up to 4.5

Mbps. UARTO (TXDO0, RXDO, RSTO & CTS0 pins) can be used for communication. It




supports fluid control. However, UARTI (TXDI pin) features only data transmit signal so, it

1s usually used for printing log.

SPI Pins: ESP8266 has two SPIs in slave and master modes: SPI and HSPI. They also include

the following general-purpose SPI features:
* 4 timing modes of the SPI format transfer
* Up to 80 MHz and divided clocks of 80 MHz

* Up to 64-Byte FIFO

SDIO Pins: ESP8266 offers Secure Digital Input/output Interface (SDIO) to cnable direct
interfacing of SD cards. There is support for 4-bit 25 MHz SDIO v1.1 and 4-bit 50 MHz SDIO

v2.0.

PWM Pins: This product has 4 channels Pulse Width Modulation (PWM). Programmable
PWM output enables the control of digital motors and LEDs. The PWM frequency range can
be changed from 1000 ps up to 10000 ps, that is from 100 Hz to 1 kHz.

Control Pins: These pins are applied in controlling ESP8266. Control pins contain Chip Enable
pin (EN), Reset pin (RST) and WAKE pin.

« EN pin — The EN pin is enabled for the ESP8266 chip, which works at minimum power if it
is driven LOW.

« RST pin — The chip ESP8266 is reset by the RST pin.

* WAKE pin — The Wake pin is used to wake up the chip from deep-sleep.



3.3 Sensor Used

1. DHTI11

The DHT11 is a very low-cost digital temperature and humidity sensor. These can be used for
wide electronics projects in the range of 0°C to 50°C with an accuracy of +2°C and humidity
from 20% to 80% with an accuracy of +5% RH. The sensor makes use of a single-wire digital
interface, therefore making it casy to integrate with microcontrollers such as Arduino or
Raspberry Pi. It's in greater demand for applications such as weather stations, HVAC systems,
and environmental monitoring, though lower accuracy and slower response times are compared

to the more advanced sensors like DHT22.

2. AQI Sensor

An AQI sensor is designed to measure the concentration of pollutants in the air for an air quality
assessment. It can detect gases, such as carbon monoxide (CO), nitrogen dioxide (NO2), ozone
(03), and particulate matter, such as PM2.5 and PM10. The sensor provides data that can be
used to determine the AQI value, which determines the level of pollution and the health threat.
AQI sensors are installed in environmental monitoring systems, smart devices in homes, and

air purifiers to improve the quality of air and public health awareness.



CHAPTER 4: HARDWARE MODELLING AND SETUP

4.1 MAIN FEATURES OF THE PROTOTYPE
The characteristics of the developed prototype are:

* The designed prototype shows a remote system of home appliances without the need for any

physical wiring.

* The prototype uses Wi-Fi to utilize wireless control, which provides an indoor range of up to

about 150 feet.

* The command to turn an appliance on and off is provided from radio buttons in the application

through one's smartphone.

* There 1s also a provision developed to use voice commands on smartphone to remotely switch

home appliances
* Any device capable of Wi-Fi connectivity can be used to control the prototype.

* The control over home appliances is obtained over secure connections, by SSL over TCP,
SSH .

* Simple design easy to integrate into a verity of appliances and extend on further range.
» The application will demonstrate the status of all appliances on your smartphone.

« Cost-effective.

4.2 PROJECT LAYOUT
Project
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Node MCU is the microcontroller unit in the prototype. It has an inbuilt Wi-Fi module

(ESP8266) that establishes wireless remote switching of home appliances.

Four channel relay module consists 4 individual relays physically connected between
Node MCU and the home appliances. It takes signals form GPIO pins of Node MCU and
accordingly connects or disconnects home appliances from the supply. They act as the

switching device.

LEDs and resistors have been used in the prototype to replace real appliances, and they
indicate when the power is being turned on and off to the appliances. Real home

appliances would replace them in the real-time operation.

Blynk application was developed for Internet of Things. It can control hardware
remotely, it can display sensor data, can store data, visualize it, etc. the prototype
primarily uses Blynk application to sense commands from user to the hardware over a

wireless network.

Google assistant is a system software available on the android phone. It interprets the

voice commands issued by the user to switch on and off an appliance.

IFTTT application the voice commands interpreted by the google assistant isn't
understandable by Blynk application thus unable to send to the hardware. IFTTT is an
intermediary application that interprets commands from Google assistant and sends on

and off signal to Blynk application Via Blynk server.

4.4 SETTING UP THE SYSTEM

4.4.1 Download and install and Blynk application in smartphone \

« Blynk application download and install in the Play store. \

« After installation of app created new account and logged in. \

» After successful login on new account, a new project is created. The project named, hardware
as Node MCU and connection type was selected as Wi-Fi then created.

* At this stage Blynk will sends authentication token to email id. This authentication token will

identify the hardware in the Blynk server.



» Since the prototype uses 4 channel relay module 4 buttons have been added at the side bar of

the screen.

* Now the 4 buttons are configured by giving a name and then selecting which of the digital
pn it will be associated to, this section will indeed impact the hardware connection as the relays

will be physically connected on the digital pins corresponded here
* Setting up for application in Blynk is now done
4.4.2 Driver installation for hardware interfacing

Devices primarily download and install drivers automatically nowadays. Windows isn't
programed to talk to the USB driver on the Node MCU and thus can't determine that this board

13 a Node MCU, therefore can't proceed normally.

* Node MCU Amica is an ESP8266 Wi-Fi module based development board. It has got Micro
USB slot that can directly be connected to the computer or other USB host devices. Ti has got
15X2 header pins and a Micro USB slot, the headers can be mounted on a breadboard and
Micro USB slot is to establish connection to USB host device. It has CP2120 USB to serial

converter.
» For installing CP2120 (USB to serial converter), user needs to download the driver for it.

« After downloading the driver as per the respective operating system of the user, the system

gets connected to Node MCU.

« The user needs to node down the COM post allotted to newly connected USB device (Node

MCU) from device manager of the system. This com port number will be required while using

Node MCU Amica.

4 4.3 Interfacing Node MCU with Arduino IDE

To begin with the latest Arduino IDE version, we'll need to update the board manager with a
custom URL. Open up Arduino IDE and go to File > Preferences. Then, copy below URL nto
the Additional Board Manager URLs text box situated on the bottom of the window

http://arduino.esp8266.com/stable/package esp8266com index json




OK. Now navigate to the Board Manager by following Tools ~ Boards ~ Boards Manager
There should be a couple new entnies bevond the standard Ardumo boards. Filter vour scarch

by typing espR266. Chick that entry. and choose Install
Figure I8, ESPR266 board installation in Ardumo IDE.

Before we move to upload sketch & play with LED. let's ensure that the correct board 1s
selected in Ardume IDE. Open Arduino IDE & make sure you have selected Node MCU 0.9

(ESP-12 Module) option in vour Arduino IDE > Tools > Board menu.

Now plug vour ESP8266 NodeMCU in using a micro-B USB cable into your computer. The
board will automatically be assigned a unique COM port once it has been inserted. On
Windows machines this will appear as COM#, and on Mac/Linux computers as
dev my usbsenal-XXXXXX. Click that serial port from underneath Arduino IDE > Tools >
Port menu, as well as the Upload Speed: 115200.

<44 Uploading Code into Node MCU
Now connect the NodeMCU through the USB cable to your PC.

Let's now configure Arduino IDE and change some options. So. open up the Arduino IDE.
Tools > Board the board. select NodeMCU 1.0 (ESP-12E Module)' and that is everything we

need to change. So, we start writing the code.

« Select Files > Examples > Blynk > Boards WIFI > ESP8266_Standalone. A new file with

some code. some of which is ready to use. opens. The following are the changes to the code.

1. The line which 1s stating ‘char auth[] = "YourAuthToken", replace YourAuthToken part with

your Blynk's authentication token that was generated by the Blynk server.

2. The line where 1t writes char ssid[| = "YourNetworkName". Replace the YourNetworkName

part with the name of the Wi-Fi network that the Node MCU should connect to.

3. Where 1t s wntten char pass[] = "YourPassword" and replace the YourPassword part with

the password of the Wi-Fi network



* The code can now be loaded onto the hardware. When the upload button 1s pressed. Node
MCU codes are uploaded, and the next time the board is powered up, 1t autoconnects to the

assigned network.

4.3 COMPONENTS REQUIRED

Component Quantity
Node MCU i
| 2 channel relay board 1
DHT11 1
LCD Display 4
MQ135 4
Blank PCB (KS100) 1
Potentiometer 1
Female pin header 1
Jumper wires 8
USB Cable 1




5.1 FLOW CHART

CHAPTER 3: LOGIC AND OPERATION
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Figure . Flow chart of prototype function.

This flow chart presents the working of the project. So, initially, WiFi is initialized, wherein in
this code names and passwords of the network are written and after getting encoded it gets
uploaded into Node MCU. The android device gets connected to Node MCU with the help of
WiFi. The Blynk server setup takes place, and connection established and subsequently this
identification is done on the devices end at Blynk server by which the authentication token

generated comes. The command that would control the load is given to the application, sent

over Wi-Fi network, and received by Node MCU.

5.2 PRINCIPLE AND OPERATION

m

15



Node MCU is an open source [OT platform. It includes firmware which runs on the ESPR266
Wi-Fi SoC from Espressif Systems, and hardware which is based on the ESP-12 module, The
term "Node MCU" by default refers to the firmware instead of the development kits. The
firmware uses the Lua scripting language. It is based on the cLua project, and built on the
Espressif Non-OS SDK for ESP8266. This utilizes open source projects like lua-cjson and

spiffs.

5.2.1 Advantages of Node MCU

* It is low cost, the Node MCU is comparatively inexpensive compared to any other IOT based

device.

* Node MCU has Arduino Like hardware I/O. It is becoming increasingly popular in recent
times that Arduino IDE has stretched their software for working in the field of ESP 8266 Field

module version.
* Node MCU has easily configurable network API.

* Wi-Fi network added with support: It is a Node MCU module having ESP 8266 which is

easily incorporated into it

* Board size reduced.

* Power consumption quite low.
5.2.2 Node MCU Disadvantages

» The functioning of the circuit is totally dependent on the operational internet connection. So.

if it is not present, then it will not work.

* Node MCU also depends upon the free server of the third party. This third-party free server

is also not operational so that it may not work.

* Official documentation resources are less in Node MCU
* Need to learn a new language as well as IDE

* Pinout reduction

5.3 BLYNK APPLICATION

..~ e e ettt e ettt s .
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Blynk apphcation is an Internet of Things primarily but it was especially designed to control
Arduino, Raspberry Pi and the likes over the internet. It's a digital dashboard where a graphic
mtertace for a prototype can be built by simply dragging and dropping widgets. It might control
the hardware. remotely situated, which would be possible to display sensor data, store and
visualize. and possess a lot more functionality. There are three major components in the

plattorm:

* Blynk Application: allows you to create fantastic interfaces for your projects using various

widgets we provide.

* Blynk Server: going to handle all communications between smartphone and hardware. You
can use our Blynk Cloud or run your private Blynk server locally. It is open-source. could

casily handle thousands of devices, and even can be launched on a Raspberry Pi.

* Blynk Libraries: for all the popular hardware platforms — enable communication with the

server and process all the incoming and outgoing commands.

Every time a radio button is accessed in the Blynk application, the message travels to the Blynk
Cloud, where it finds the specific hardware by the unique gencrated authentication token.

Works the same way the opposite direction.



CHAPTER 6:

6.1 RESULT The experimental model was constructed based on the circuit diagram and the
results were as expected. The home appliances could be remotely switched over Wi-Fi network.
Both the switch mode and the voice mode control methodologies were successfully achieved.

The Blynk application was also successful in displaying the status of every application.
6.2 LIMITATIONS

Android devices with a lower API version than 16 need internet facility to convert the speech
data to string data. Currently, our application is made for Android Smart Phones: other OS
platform doesn't support our application. While using the voice mode, external noises (voice)
may affect our result. The speech instruction that we command in our voice mode may not give

us an exact result as expected. There hence lies an ambiguity in result.
6.3 FURTHER IMPROVEMENT AND FUTURE SCOPE

Considering the present scenario we can develop such cross platform system that can be
implemented on different platforms like iOS, Windows etc. The limitation of control over only
few devices can be eliminated by extending the automation of all other household appliances.
The prototype can be an LDR that can sense daylight and switch the lamp accordingly, PIR for
security purpose, to make alarm buzz in case it detects motion, or DHT 11 sensor that senses
ambient temperature and humidity of the atmosphere and switches fan/air conditioner
accordingly. The scope of this project can be extended to many areas, rather than limiting itself

to the home, and stretched into small offices

6.4 CONCLUSION

It is rather obvious from this project work that with an individual control home automation
system, one can easily make it cheaply using low-cost locally available components. It will
thus be possible for someone to automate multifarious home appliances ranging from security
lamps, the television to the air conditioning system and even the whole house lighting system.
And better still, the components required are so small and few that they can be packaged into
a small inconspicuous container. The designed home automation system was tested a number

of times and certified to control different home appliances used in the lighting system.
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